## Index

- **Knowing the Environment** ............................................. 3
- **Drag and Drop** ........................................................... 3
- **Sprite Concept** ............................................................ 4
- **Preparing a Custom Sprite** ........................................... 4
- **Modifying the Textures of the Sprite Elements** .................. 5
- **Project** ....................................................................... 8
- **Project Settings** ............................................................ 8
- **Defining Your Own Actor** .............................................. 9
  - Mix-matching Composite Characters from the Library .......... 9
  - Head Types in CrazyTalk Animator .................................. 10
- **Customizing Your Actor With Character Composer** ............ 11
  - Changing Parts of a Character ....................................... 11
  - Using Predefined Sprites to Compose a Face .................... 12
  - Changing the Layer Order - Body Parts and Facial Features ... 12
- **Creating Custom Actors from Photos** ............................... 14
  - Creating a Face from a Photo ....................................... 14
- **Scene** ........................................................................ 24
  - What is a Scene? .......................................................... 24
  - Building a Custom Scene .............................................. 24
  - Adjusting the Z Values with 3D View .............................. 26
- **Prop** .......................................................................... 27
  - What is a Prop? ............................................................ 27
  - Creating Composite Props with the Prop Composer .......... 28
  - Modifying Sprite Transformations of a Prop .................... 28
  - Using the Attach Feature .............................................. 29
  - Locating the Center .................................................... 30
- **Special Effect** ................................................................ 31
  - Using Text .................................................................... 31
  - Using Special Effects .................................................. 31
- **Animations** .................................................................. 32
  - Animation Concepts .................................................... 32
  - Character Animations - Face Animation ......................... 37
  - Character Animation - Body Animation ......................... 42
  - Camera Animation ..................................................... 53
- **Using Timeline** ............................................................. 54
  - Introducing the Timeline .............................................. 54
  - Clip and Key Priority ................................................... 57
  - Using Tracks ............................................................... 58
- **Introducing the Export Page** .......................................... 60
CrazyTalk Animator is a revolutionary animation suite with all the necessary tools to easily create pro-level animation. CrazyTalk Animator’s stage is a 3D-layered 2D studio where you can drag and drop actors, props, sceneries, images and videos directly onto the setup stage. Create actors from any photo or illustration using CrazyTalk Animator’s innovative Actor Creator wizard. Bring actors to life with automatic facial animation & innovative puppeteering motions. Drag & drop to build sets with scenery and props. Film and direct all the action with camera & timeline tracks for complete 2D animation.

Knowing the Environment

Drag and Drop

CrazyTalk Animator provides several drag and drop methods to accelerate the building of your scene.

Adding Objects

Adding objects including: characters, props, image layers, effects, texts and backgrounds, can all be done by drag-and-dropping from different sources.

A. From the Content Manager Library
B. From Source Folder

The supported file types:
- Image: BMP, JPG, TGA, PNG, GIF, SWF.
- Video: AVI, WMV, RM, MP4 for PC, Mpeg, FLV.
- Others (Transparent Videos): iWidget, popVideo.

Dragging for applying

Character in Stage Mode

You are able to drag and drop any template from the Animation libraries (Motion, Face, Perform and Action Menu) to any character instead of selecting the template and clicking the Apply button.

Character in Composer Mode

When you select a character and switch to the Character Composer mode, then you can drag and drop any props onto any body parts. CrazyTalk Animator will automatically attach the prop to the body part.

- Drag and drop a motion template onto the character.
- Drag and drop a prop onto the character.
- The prop instantly attaches to the body part.
Taking 2D Animation to the Next Level

- **Assets Collection**
  You can drag and drop one or more assets from the Content Manager into your desired folder to create your custom library collection.

  ![Drag and drop assets from CrazyTalk Animator to a folder.](image)
  ![Build a custom library collection.](image)

- **Sprite Concept**
  **What is a Sprite?**
  A Sprite can be best understood as a group that consists of lots of different media files. Though it can have multiple elements, it only shows one of them at a time. Sort of like a slide show.

  The elements of a sprite can be media files with different formats:
  - **Image:** *.jpg, *.bmp, *.gif, *.png, *.tga
  - **Reallusion Specific Format:** *.iWidget, *.popVideo

  **Preparing a Custom Sprite**
  You can load different types of media, videos or images to create a sprite. When a sprite contains a series of image or videos, then you may create Image Replacement Animations in Stage mode with setting keys.

- **Loading Media to Form a New Sprite**
  **Prop**
  1. In Stage Mode, click the Import Media button on the left-side tool bar.
  2. Click the Props button in the Import Media panel.

  Load multiple media files. A sprite with multiple media files will be created afterward.

- **Modifying the Textures of the Sprite Elements**
  If you want to change the texture of any element in a sprite, then you need to enter the Composer Mode.
  In the Composer Mode, you may use the Color Editor tool to perform basic modifications to the elements, or you may use an external image editor for advanced modifications.
  The Color Editor may help you with editing Vector-based and Image-based elements. But take note that the External Image Editor is more suitable for editing Image-based elements.

- **Editing Vector-based and Image-based Elements**
  **A. Basic Usage - Editing Single Sprite**
  1. Pick one of the sprites in the Composer Mode.
  2. Click the Color Editor button.

  ![Click the Color Editor button.](image)

  3. Drag the sliders of the Color Editor panel to adjust the basic color of the texture.

  **B. Advanced Usage - Affecting All Sprite**
  The Color Editor provides features for you to modify the character’s skin, hair, clothes, and others as a group. This way you do not need to modify them individually.
  1. Select a character, and then enter the Composer Mode by clicking the Character Composer button.
  2. Select the face and then click the Color Editor button.
  3. Select Skin in the Choose Group drop-down list.

  ![Select Skin in the Choose Group drop-down list.](image)
If you want to use an external image editor to modify an image-based element, then follow the steps below:

1. Pick a character in the Stage Mode. Click the Character Composer button to switch to the composer mode.

2. Select one of the body parts and then click the Sprite Editor button.

3. Pick the element in the list for editing.

4. Modify the Brightness, Contrast, Hue and Saturation value. You can see that only the face skin is modified.

5. If you activate the Affect All box, then the character’s entire skin color will be modified.

6. Edit the image and save. The data will then be automatically transferred into CrazyTalk Animator.

7. Click the Back to Stage button to update the character in the Stage Mode.
Project

Project Settings

In the Project Setting panel you may adjust the length of the project, the time unit shown on the time counter, the viewing method of the camera and the background. Click the Project Setting button to open the Time Setting panel.

Time Setting Section

- **Animation Length**: Shows the total length of the project in frame count. The default length for each project is 900 frames. The maximum frame number is 27000.
- **Select Time Unit**: You may decide to display the time unit in either frame format or time format.

Camera Setting

The camera setting decides the viewing method of the camera.

- **Perspective** (Keyboard Shortcut: O): This method shows the Z-depth relation of each item inside. The size of the objects, in theory; alter automatically in accordance to the distance of the item.
- **Orthographic** (Keyboard Shortcut: O): This method shows the project regardless of the Z-depth of each object inside. This method is used by most image editing software since Z-depth is unnecessary for them. Therefore, the size of each object looks the same even if it is far away from the camera.

Background Setting

In this section, you may set the background of your project to a solid color or to a prepared image. Click the Color Picker to select a solid color as the background of the current project. Activate the Active Image box and then click the button to load any prepared image as the background. Select from the Display Mode drop-down list to define the mapping method for the image background.

Video - External Files

By default, CrazyTalk Animator compacts all loaded video files into a project file, which increases the total size of the project. To prevent this, you may click on the External Files button to have all the video files saved as external files. This can solve the over-sized project issue. However, do remember to move all the video files together, along with the project file if you move the project to another folder destination.

Defining Your Own Actor

Mix-matching Composite Characters from the Library

Creating a Character from the Library

1. Go to Actor >> Character. The Content Manager will then switch to the character library.
2. In the Template tab, double click on (or drag and drop) one of the templates to apply.
3. Select the character if it is not selected.
4. Change the Content Manager to Actor >> Head library
5. Apply different head templates from the Template or Custom libraries found in the Content Manager.
6. Change to Actor >> Body library.
7. Apply different body templates from the Template or Custom libraries found in the Content Manager.

Head Types in CrazyTalk Animator

There are three types of heads in CrazyTalk Animator. You can create them by loading and fitting with an image, composing with various feature parts, or mix up these two types of head.

- Morph-based head
  - This type of head is created by the Face Creator. The eyeballs and teeth are inside of the head like a real person.
  - You can also modify this kind of head by the Face Creator in the Character Composer.

- Sprite-based head
  - This type of head is created by the Character Composer. Each facial feature is pasted onto a face to composite a head.
  - If you want to modify this kind of head, then you need to use the Character Composer.

- Hybrid head
  - You can mix up the two kinds of head to generate special character by both creating methods above, as well as modification.
  - The facial features from the Face Creator and from the libraries in the Character Composer >> Head can be puppeteered or set facial keys simultaneously.
  - Please switch to the Actor >> Head, and apply hybrid head from the Head >> Human >> Hybrid library.

Customizing Your Actor With Character Composer

Changing Parts of a Character

In the Mix-matching Composite Character from Library section, you can perform basic character compositions by changing the head and the body from the Content Manager. You may use the advanced method to compose a character with the Composer features.

- Compositing a Character
  1. First select a character.
  2. Click the Character Composer button to switch to the Composer Mode.
  3. Click the Head >> Head button on the top panel. Apply a head template from the Content or Custom libraries.
  4. To change to the corresponding libraries, simply click the Body button on the top panel and then click the sub-buttons that belong to the body.
  5. Apply templates from any of the libraries found. (Upper to Tail)
  6. Click the Back to Stage button to update the original character.
Using Predefined Sprites to Compose a Face

CrazyTalk Animator contains facial feature libraries with lots of templates (predefined sprites) inside for composting faces.

1. You must first select a character.
2. Click the Character Composer button to switch to the Composer Mode.
3. You may also delete the entire head to create a new one.
4. Click the Head button on the top panel. Click the sub-buttons that belong to the head, in order to change to the corresponding libraries.
5. Apply desired template from the Face and Hair libraries.

Please note that there is no specific order to applying the facial features. However, it is highly recommended that you first apply the Face before the others.

Changing the Layer Order - Body Parts and Facial Features

In CrazyTalk Animator, each character is composed of body parts and facial features (sprites). Therefore, there is a certain layer order for them. You may change the order manually with the Character Composer, so that when the character scratches its head, the hand will be behind the head instead of being in the front of it. You may also use this method to stylize faces and hairdos.

- Changing the Layer Order

Please follow the below steps to reorder the layer of a body part and/or facial feature:

1. Select a character.
2. Click the Character Composer button. Please note that the character will return to its initial pose inside the Composer Mode.
3. Rotate a body part to check the order.
4. Switch to the Layer tab in the Scene Manager.
5. Select the item for which you want to change the order.
6. Click the Move to top, Move up, Move down, and Move to bottom buttons to re-arrange the order of the selected item.
7. Rotate the part again to review the result.
8. Click the Back to Stage button to update the character.
Creating Custom Actors from Photos

Creating a Face from a Photo

There are two methods for you to create a head (face) from an image. Once a head is fully created in CrazyTalk Animator, then the converted image character will be able to talk with expressions. Please note that only image characters whose heads have been fully created will be able to have expressions on their face.

The supported image formats are: JPG, BMP, TGA and PNG.

Whenever you see the Face Creator button enabled in Stage Mode or Character Composer mode, then you will be able to create a new face from a photo with the Face Creator.

There are three steps in the Face Creator:

1. Select a character.
   You may use the tools on the left side of the image processing menu to adjust the area, quality, and color settings of the image.

2. Automatic Image Fitting
   The 4-point auto fitting for the basic anchor points allows you to create a CrazyTalk Animator model in just a few clicks. This process is entirely automatic and requires no complex frame fitting techniques. Once you create a basic frame to fit the face, then you can use the fitting tools to increase the definition of the wire frame by simply adjusting the additional frame points.

CrazyTalk Animator has its own embedded estimation of the four points which define the eye and mouth areas. If you wish to move the positions, then you may click and move the numbered indicators 1, 2, 3 and 4, on the image. Do this to adjust the fitting process as displayed in the reference image. Click the Reset button at any time to cancel your actions and start over.

3. Face Fitting
   In the Face Fitting page you may detail the wire-frames and control points of the face, set the side face style, modify the background mask, and apply virtual eyes and mouth.

Facial Wireframe Modes and Replacing Face Images

On the left-side tool bar, the Fitting Mode is pressed as the default button. This helps you fit the feature points to all appropriate locations.

If you wish to change the face image without affecting or re-arranging the wireframes or facial points, then you use the Replace Image feature.

Image Processing

The image processing tools allow you to enhance the quality of selected images. You may rotate and crop them in order to work with a portion of the original image source. This allows you to focus on facial details in order to create more accurate talking characters.

1. Select a character.
   You may use the tools on the left side of the image processing menu to adjust the area, quality, and color settings of the image.

2. Automatic Image Fitting
   The 4-point auto fitting for the basic anchor points allows you to create a CrazyTalk Animator model in just a few clicks. This process is entirely automatic and requires no complex frame fitting techniques. Once you create a basic frame to fit the face, then you can use the fitting tools to increase the definition of the wire frame by simply adjusting the additional frame points.

CrazyTalk Animator has its own embedded estimation of the four points which define the eye and mouth areas. If you wish to move the positions, then you may click and move the numbered indicators 1, 2, 3 and 4, on the image. Do this to adjust the fitting process as displayed in the reference image. Click the Reset button at any time to cancel your actions and start over.

3. Face Fitting
   In the Face Fitting page you may detail the wire-frames and control points of the face, set the side face style, modify the background mask, and apply virtual eyes and mouth.

Facial Wireframe Modes and Replacing Face Images

On the left-side tool bar, the Fitting Mode is pressed as the default button. This helps you fit the feature points to all appropriate locations.

If you wish to change the face image without affecting or re-arranging the wireframes or facial points, then you use the Replace Image feature.
**Specifying Face Orientation and Style**

Click the Face Orientation button to adjust the profile style. Then define the face orientation of the character:

- **Preview Mode**
  In the Preview Mode you may review facial fittings, eyes, mouth and background mask results.

- **Basic Facial Mode and Detailed Facial Mode**
  You may click the Basic Facial Mode or Detailed Facial Mode button to view the wire frame around your character. You may also drag the control points, or lines, to fit a character’s face more precisely.

  - Click the Select button to pick and move components of the wire frame.
  - Click the Rotate button to rotate the wire frame or the frame component (wire).
  - Click the Scale button to adjust the size of the wire frame.
  - Click the Open/Closed Mouth Points button to close the mouth points of the wire frame. This will cause the points of the upper and lower lip to move together as a single line. If your model has a closed mouth, then we suggest you to use this option. This option is available only when you select the Detailed Facial Mode.
  - Click the Calibrate button to play back a short script intended for calibration. Click the down arrow next to it if you wish to select a specific part of the face. This option is available only when you select the Detailed Facial Mode.

- **Defining the 3D Face Orientation**
  Utilize the Rotate tool to fit the angle of the character’s face. This will ensure that the 3D mesh of the head will match the facial angle of the character in the photo.

- **Selecting Appropriate Face Style**
  1. Select one of the 9 basic profiles to fit your character.
  2. Drag the Strength slider to adjust the intensity of the profile. The higher the value, the more accentuated the profile and motion of the character will be.
  3. Press the Preview button and move your mouse to preview the head motion in the main viewport. If the motion is not as desired, then re-adjust the Strength value or try another profile style.

### Editing the Background Mask

The background mask hides all unnecessary areas of the loaded photo. This helps you only the areas you are interested in, such as the character’s head.

There are two methods to generate a background mask for your image:
- Utilizing Background Mask Editing panel.
- Utilizing external image editor before the image is loaded.

- **Using Background Mask Editing Panel**
  - Click the Full button and then click on the image to fill with the mask color. You may adjust the Tolerance slider to increase or decrease the background mask over the image target area.
  - Click the Clear button to delete the background mask.
  - Click the Inverse button to invert the background mask area. The area that was previously defined as the background mask will now be inverted with the non-masked area.
Taking 2D Animation to the Next Level

If you wish to perfect your image mask, then you may pre-save your image with a pre-defined alpha channel. This can be done by means of an external image editor. Once you create your mask outside, simply load the image into CrazyTalk Animator. The alpha channel information will automatically be applied as the background mask in the Background Mask Editing panel.

Note:
- The alpha channel information can be in 32-bit BMP, TGA or PNG format.
- If you wish to save the source image as PNG file, then remove the background layer, erase any unnecessary area of the image and save. You do not need to create an alpha channel layer in the Channels panel.

VividEye Technology

CrazyTalk Animator introduces VividEye Technology in a layer-based concept. The 6 Layers (Eyeball - Iris, Eyeball - White, Eye Light, Eye Shadow, Eyelash and Makeup) in the VividEye Settings greatly increase the realism of virtual eyes. Original eyes from the source image cannot roll, so it is important to add virtual eyes to the animation.

Click the Eye Setting button at the left-side tool bar to access the VividEye Technology.

After you apply a virtual eye template, switch to the Modify tab to use the advanced adjustments below:

Eyeball Transform

After applying an eye template, you may adjust the size and the location of the eyeballs.

1. Switch to the Modify tab.
2. Select the Right or Left eyeball from the drop-down list.
3. Choose the Eyeball - Iris or Eyeball - White radio button.
4. In the Transform section, adjust the Scale value to decide the size of the eyeball.
Eyeball Iris Color and Eyeball Whites

You may customize the color of the eyeball by changing the diffuse color of the iris and adjusting the whiteness.
1. Please make sure the head has virtual eyes applied.
2. Select the Right or Left eyeball from the drop-down list.
3. Choose the Eyeball - Iris or Eyeball - White radio button.
4. In the Color section, adjust the values for Brightness, Contrast, Hue and Saturation.

Eye Light

The Eye Light simulates the specularity effect on the eyeballs, which implies the light direction. This feature facilitates you in creating sparkling, crystalline, or turbid eyeballs.
You can also use custom light shapes by loading a grayscale image into the Opacity channel.

Design the Light Shape

There are three sections in the modify page involved in the designing of light shapes: the Opacity channel, the Transform, and the Opacity/Blur sections.
1. You must apply an eye template from the eye gallery first.
2. Select the Right or Left eyeball from the drop-down list.
3. Choose the Eye Light radio button.
4. Double click on the Opacity icon, or click the button, to load a grayscale image that will decide the shape of the eye light.
5. In the Transform section, adjust the position and the size of the eye light.
6. In the Opacity/Blur section, adjust the value of the Opacity and Blur to decrease the overall-sharpness appearance.

Eye Shadow

The Eye Shadow features the strength of the sphere effect on the eyeballs. You may decide the size of the shadow, the color of the Diffuse image, and the opacity and blurriness of the Opacity channel.

Set the Sphere Sense of the Eyeball

If you need to set the sphere-feeling of the eyeball, then you may adjust the Opacity channel to increase/decrease the sensation.
1. Select the Right or Left eyeball from the drop-down list.
2. Choose the Eye Shadow radio button.
3. Select the Opacity icon. Set the values in the Opacity/Blur section.

Eyelash

CrazyTalk Animator offers you Eyelash effects to generate a more vivid appearance in the eyes. You may apply the Eyelash effect to mimic mascara, and enhance the eyelashes of the model. Notice that female eye templates contain longer eyelashes.

1. Select the Right or Left eyeball from the drop-down list.
2. Choose the Eyelash radio button.
3. In the Color section; adjust the value of Brightness, Contrast, Hue and Saturation to change the color of the eyelashes.

Length of Eyelash

You can decide the length of the eyelashes by adjusting the Size value.
CrazyTalk Animator offers Makeup effects to generate vivid eyes. With the Makeup feature, you may generate various make-up styles such as Smokey, golden shimmering or bruised eyes. You can also use it to conceal or cover creases or defects on the models’ eyelids. Distortions and stretching issues, created when models close their eyes, can also be covered with Makeup effects.

1. Make sure you have applied an eye template to the character.
2. Select the Right or Left eyeball from the drop-down list.
3. Choose the Makeup radio button.
4. In the Color section, adjust the values for Brightness, Contrast, Hue and Saturation.
5. In Opacity/Blur, adjust the Opacity and Blur values to define the clarity of the makeup.

Mouth Settings

Every character in CrazyTalk Animator is able to talk. You may apply a virtual mouth with teeth, along with modifying the mouth color and lips settings on the character.

Applying Mouth Template

1. In the Face Fitting page, click the Mouth Setting button on the left-side tool bar.
2. Apply one of the templates from the Template library.

Teeth

After you apply a virtual mouth, you may then modify the location, orientation and the color of the teeth inside the mouth.

Teeth Location and Angle

1. To set the size of the teeth, use the Scale feature. Adjust the X/Y values to adjust the width and height of the teeth.
2. To specify the position of the teeth in the mouth, use the Move parameters. Adjust the X/Y values to relocate the teeth.
3. Use the Rotate value to decide the orientation of the teeth and match the angle of the mouth.

Teeth Color

Use the Color Settings feature to choose the color of the teeth. Move the Brightness, Contrast, Hue, and Saturation sliders to adjust the teeth color. Alternatively, enter a number in the boxes next to the slider bar to change the parameter value.

Throat

CrazyTalk Animator lets you modify the inner mouth and throat color for when mouths need to be opened wide.

1. Choose the Throat radio button.
2. In the Color section, adjust the value of the Brightness, Contrast, Hue and Saturation.

Lips

Most of the time, characters in photos smile. However, the mouth shape may not be as natural as you might expect when characters talk in CrazyTalk Animator. This is because the height of the lip corners. You may use the lip settings to lower the lip corners and keep the mouth line as flat as possible. After you apply a virtual mouth, you may modify the corners of the lips.

1. Choose the Lips radio button.
2. In the Lips corner section, adjust the position values of the Left Corner and Right Corner.
3. Activate the Force to Close box to close the character’s mouth.

• Check the Force to Close checkbox to close the model’s lips. This feature is useful when the original image has an open mouth. Make sure that the control points for the open lips are correctly specified when adjusting the wire frame.
Scene

What is a Scene?

In a CrazyTalk Animator project, you can apply one and only one scene, which is made of a group of props. You may then store all well-organized props and background into a single scene file. This saves a lot of time by adding and applying them back when you need them.

The characteristics of a Scene template:
- A scene template is able to include props and background.
- Scenes are exclusive to each other.
- You are allowed to build a custom scene by adding more props into the scene.
- Props in a scene can be extracted.
- If a scene must be use in a different time of day (day, night), then do not apply a background before producing a custom scene template.

Building a Custom Scene

CrazyTalk Animator is an image-based animation tool. Every prop inside is made of one or more images.

You may use various props to build up a CrazyTalk Animator scene.

Building a Scene

1. In Stage Mode, click the Import Media button and select a prop in the panel.
2. Load a media file and convert it into a new Prop.
3. The newly-added props are all under the Prop item in the Scene Manager.
4. Right-click on the prop you want to add to the scene. In the right-click menu, select the Add to Scene feature.
5. Look at the Scene Manager, you may see that the prop is now moved under the Scene item.

Extract Props from a Scene

After you apply a scene template from the library, then you may extract the props within the scene. The props will not be replaced during the next scene replacement.

1. Apply a scene template from the library.
2. In the scene manager, you may see all the props within the new scene.
3. Select the desired prop and right-click on it.
4. Choose the Convert to Prop command. The prop will be moved under.
5. Apply another scene template. This prop will not be replaced while all the other props under the Scene will be replaced.

Using Media with Masks

It is highly recommended for you to load media with masks (alpha channel) so that the when the media files are loaded into CrazyTalk Animator then the unnecessary parts are filtered out. The supported file formats (with masks) are *.png, *.tga (32 bits), *.bmp (32 bits), *.gif, *.popVideo and *.iWidget.

Without Mask

With Mask
Adjusting the Z Values with 3D View

Even though CrazyTalk Animator is a 2D-based application, it still contains a Z depth system. Each character and prop possesses its own Z-depth layer that determines the distance of it from the center of the project.

Using 3D View to change the Depth
1. Add characters and props to the working area.
2. Select a character or a prop.
3. Click the 3D View button to switch the camera to the 3D top view.
   - Drag with the right-mouse button to change the angle of the camera.
   - Drag with the left-mouse button to pan the camera.
4. Drag the blue arrow to change the Z-depth of the selected item.

Using the Mouse Wheel to change the Depth
1. Select a character or prop.
2. Roll the mouse wheel and you will notice that the Z-depth will start to change.
   - Roll the wheel UP to increase the Z value.
   - Roll the wheel DOWN to decrease the Z value.

Prop

What is a Prop?
In CrazyTalk Animator, each prop can be composed of at least one sprite. In another words, a prop is usually a group of at least one sprite. The individual sprite, that forms the prop, can have more than just one element. The format of the element can be a image or video.

The structure concept is described in the following illustrations:

- A prop with a sprite containing a single media file.
  1. Prop (invisible) on the stage.
  2. Sprite (invisible) in the prop.
  3. Element (visible) in the sprite.

- A prop with multiple sprites. Each sprite contains one or more media files.

Below is another example with item structures:
Creating Composite Props with the Prop Composer

After creating props in the Stage Mode, you may use the Composer to make props contain other sprites.

- Creating a forest with a single tree

1. Apply a tree prop and select it in the Stage Mode.
2. Switch to the Composer Mode by clicking the Prop Composer button.
3. In the Composer Mode, look inside the Scene Manager and you will notice that the prop only contains one sprite.
4. DO NOT select the prop. Just apply the same tree prop over and over again from the library.

Please note that in the Composer mode, this step is merely borrowing the sprite from the prop library.
5. Click the Back to Stage button and select Yes to update the prop.
6. You have now created a Forest with one single prop.

Modifying Sprite Transformations of a Prop

Inside the Composer mode, you may adjust the position, the orientation and the size of each prop sprite. This may alter the appearance of the prop. With this feature, different props with identical sprites inside, may look different due to the modifications of the transform data.

1. In the Stage mode, select a composed prop with compound sprites.
2. Click the Prop Composer button.
3. Pick one of the sprites that belong to the prop. You may then see the transform handle appear around the sprite.
4. Move, scale or rotate the sprite.
5. Repeat the steps to transform one or more sprites inside.
6. Edit the texture for each sprite. Please refer to the Modifying the Textures of the Sprite Elements section for more information. Click the Back to Stage button to update the prop.

Using the Attach Feature

After you create composite props with the prop composer, the components, also named sprites, are all at the same level under the root node. However, you may need to group some sprites together to have them animate at the same time. Use the Attach feature to group them.

Attach Feature

1. In the Stage Mode, select a compound prop created earlier.
2. Click the Prop Composer button.
3. Switch from the Scene Manager to the Scene tab.
4. Select a sprite which is a child of another one.
5. Click the Attach button and pick another sprite which you want as a parent.
6. The sprite will then be moved under the new parent.
7. If you transform the parent, then the child will be affected as well.

Note:
- The Attach feature can only be done in the Composer Mode.
Locating the Center

The center (also called “Pivot”) of a character or a prop decides the base for position, rotation and proportion change in the Stage mode. You may use the Composer to locate the center of any character or prop.

**Locating the Center of a Prop**

1. In Stage Mode, select a prop. You will notice that the center of the prop is inside a circle.
2. Click the Prop Composer button.
3. Select the root sprite of the prop in the Composer Mode. (The root sprite can be found in the Scene Manager >> Scene)
4. Turn on the world axis by using the hotkey: Ctrl + A.
5. Drag the sprite away from the world center (where the axis coordination is).
6. Click the Back to Stage button.
7. The center of the prop is now different. You may rotate or scale the character or prop, to see the difference.

**Locating the Center of a Sprite**

1. In the Stage Mode, select a prop.
2. Click the Prop Composer button.
3. Select a sprite. A transform handle box will appear around the sprite.
4. The red point is in the middle, which will cause an incorrect sprite rotation.
5. Drag the Red Point away from its original position. This point is the center, or the pivot of the sprite.
6. Click the Back to Stage button.
7. The center of the sprite will now be relocated. Click the Prop Key Editor button, pick the sprite and then rotate it.

Special Effect

**Using Text**

If you wish to display comic text when the character is talking, then simply use the text embedded inside CrazyTalk Animator.

1. Load or create a project.
2. In the Stage Mode, switch to Special FX >> Text.
3. Apply one of the templates to your project.
4. Double-click on the text (or click the Text Editor button) and modify the text inside.
5. The modified text will now appear in the stage.

**Using Special Effects**

If you wish to apply special effects to your scene, then you may use the special effects embedded in CrazyTalk Animator.

1. Prepare a project which you wish to add special effects to.
2. In Stage Mode, switch to Special FX >> Object.
3. Apply one of the templates to your project.
4. Move, scale or rotate the effect to where you need it.
Animations

Animation Concepts

Creating a Path Animation

Once you create a character or a prop, you may then create a path for it. When you playback the project, the character or prop will then move along the path you set.

Creating a Transform Path

1. Select a character or a prop (character in this example) in the Stage Mode. By default, CrazyTalk Animator switches to the Transform mode as soon as you select a character or a prop.
2. Go to another time frame.
3. Set a key by transforming inside the working area. A green path automatically forms.
4. If you want to set a key on the Z axis, then you may do so by adjusting the Z values with 3D view.

Editing the Path Shape

Once the path is created, you may need to edit it.
1. Go to another time frame. Move, scale or rotate the prop away in order to generate a new transform key.
2. Repeat Step 1 to add more points to the path.
3. Drag a point on the path, but away from its current location. The line between the two key points will be automatically modified.
4. Click the Transform button on the tool bar above the working area.
5. Switch between the Curve and Line buttons to change the path from a curve to a straight line.

Sprite Animation

Sprite Transformation Animations

Since props are usually composed of a group of at least one sprite, you may imagine a prop as a container that contains one or more sprites. The container will perform its own animations while the sprites inside of it perform their own individual animations.

1. Select a prop (with one or more sprites) in the Stage Mode.
2. Click the Prop Key Editor button on the left-side tool bar. The Prop Key Editor panel will appear.
3. Select the target sprite in the prop.
4. Move, rotate or scale the sprite to set a transform key.

How to rotate a sprite around?
Use three keys to make a sprite turn around - 0-->179-->359 instead of 0-->180-->359.
5. Go to another time frame and add a new transform key.
6. Repeat Steps 3 to 5, to create a transform animation for another sprite in the same prop.
7. You may also set a path for the prop to move along. Please refer to the Creating a Path Animation section for more information.

Sprite Switch Animations

Creating Sprite Switch Animations

Once you have a sprite that consists of multiple media, then you may use it to create sprite switching animations. By selecting one of the sprite’s media in different time frames, the sprite shows different appearances when played back.

Take note that this feature supports both characters and props.

1. In Stage Mode, click to select a character or a prop.
2. Click the Sprite Editor button.
3. Go to another time frame.  
4. Pick one of the media files in the Sprite Editor panel.  
   A switch key is automatically set.  
   Please note that in this example, the picked element is an animation.

5. Play back the project. When it comes to the frame where the key is set, the picked file from the last step will show.

### Making a Turn by Flipping Side

When you create a back and forth motion path for a character or a prop, you may need it to face the other side at a certain point so that it does not seem to be moving backwards. This is especially useful if you want to make vehicles or strolling pedestrians approach the scene from a distant perspective.

1. Select a character or a prop that moves from left to right and left again along a path.
2. Once the prop reaches the middle point of the path, it will be necessary to flip the prop’s facing side.
3. Drag the play head to the time frame where the character or the prop’s side is supposed to turn.
4. Click the `Flip` button on the tool bar above the working area. The prop will then be flipped for the rest of the path unless you flip it again.

5. By default, characters and props flip horizontally. You may drag down the list and click the triangle to set flip to horizontal or vertical.

### Using the Mouse Cursor in the Motion Key Editor and Puppet Editor

You may use the Motion Key Editor and Puppet Editor to produce a character’s facial expressions and body motions. However, when these panels show, there are specific reaction areas for your mouse movements to take effect. The mouse movements can be categorized into two aspects: Cross Movements and Circular Movements.

#### Cross Movements - Face Key Editor and Face Puppeteering Panel

**Face Key Editor**  
The reaction area for the Face Key Editor is described below. You must drag across from the inside to the outside of the area in order to control the facial features:

**Face Puppeteering Panel**  
When you Preview or Record facial expressions, the mouse cursor will jump to the center of the main program. The reaction area is the whole program. If you move the mouse cursor outside of the reaction area, then the character pauses.

#### Circular Movements - Body Puppeteering Panel

When you use the Body Puppeteering Panel to preview or record body motions, then you use a circular mouse movement to control.

Please notice:
- You must drag a circular movement around the mark inside the working area.
- The motion speed is determined by how fast you draw the circle.
Clockwise Direction
If you drag the mouse in clockwise direction, then the character motion performs forward.

Counterclockwise Direction
If you drag the mouse in counterclockwise direction, then the character motion performs backwards.

Partial Circular Movements
You do not need to always make a full circle around the mark to produce a complete motion. You can move back and forth in an arc movement to puppet the character in a partial movement of the preset motion.

Character Animations – Face Animation

■ Five Approaches to Generating Facial Expressions

There are five main methods to generating facial expressions for a character.

Facial Expressions from the Library
The easiest way to apply character expressions is by choosing templates from the Content Manager. To do this, simply click the Animation tab on the top panel.

Templates Containing Facial Expressions
You may apply facial expressions, from several types of motion templates, found in the library list below:
- Face
- Perform
- Action Menu
1. Select a character.
2. Double-click on the desired template (or drag and drop the template onto the character) from the Face or Perform library.
3. The character will then proceed to act out the expression.

Using the Sprite Editor to Switch Facial Expressions
The facial features of a Sprite-based head are actually sprites with one or more elements inside. By using the Sprite Editor, you may switch to any element in a facial feature. Elements compose various expressions on the character’s face.
1. Select a character with a Sprite-based head.
2. Go to different time frame.
3. Click the Sprite Editor button.
4. Pick any facial feature. You may see all the feature elements listed in the Sprite Editor.
5. Select one of the elements, to set a Switch to the feature.
7. This way, different facial expressions can be easily composed.
8. Go to a different time frame and repeat the procedure to assign other expressions to the character.
Using the Face Puppeteering Panel

CrazyTalk Animator combines facial animation with revolutionary, real-time puppeteering controls to empower users with easy-to-use facial expressions commands.

Full Face Control Puppeteering

The Full Face control Puppeteering uses presets for puppeteering and recording expressions. If you are using a Hybrid Head, then it is highly recommended that you use the Solo Feature Selection Puppeteering method to create facial expressions.

1. Select a character and click the Puppet Editor button.
2. If the Body Puppeteering Panel shows, then click the Switch to Face Puppet button.
3. Pick a desired profile from the Face Animation Profile list.
4. Choose a preset in the Full Face Control list.
5. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar.) The cursor will automatically be positioned in the center of the CrazyTalk Animator window (the mouse interactive area covers the entire CrazyTalk Animator interface).
6. Move your mouse to puppet. The selected face will be triggered to move with the mouse cursor. Press the Space bar again to stop previewing.
7. Click the Record button and press the Space bar (Or press the Alt + Space bar) to start recording the motion as puppeteered by your mouse. (Press the Enter key to start the half-speed recording mode)
8. Once the recording stops, a clip with all the recorded expressions will be stored in the Facial Clip Track of the character.

Solo Feature Selection Puppeteering

When you do not wish to use puppeteering presets, and you wish to record the expressions of a single facial feature, then you can use the Solo Feature Selection pane for puppeteering.

1. Select a character and click the Puppet Editor button.
2. Click the Switch to Face Puppet button.
3. Click the Clear Selection button. All the selected features will be deselected.
4. Pick the desired facial features from the Solo Feature Selection pane.
5. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar) The cursor will automatically be positioned in the center of the CrazyTalk Animator window (the mouse interactive area covers the entire CrazyTalk Animator).
6. Move your mouse in order to puppet. The selected face will be triggered to move with the mouse cursor. Press the Space bar again to stop previewing.
7. Click the Record button and press the Space bar (Or press the Alt + Space bar) to start recording the motion as puppeteered by your mouse. (Press the Enter key to start the half-speed recording mode)
8. Once the recording stops, a clip with all the recorded expressions will be stored in the Facial Clip Track of the character.

Multi-Layer Recording

When you follow the instructions in the Solo Feature Selection Puppeteering section, then you are generating a facial clip expression at one time. However, you may also apply the multi-layer recording method to record the feature motions individually.

1. Launch the Facial Puppet panel.
2. Go to a time frame when you want the puppeteering to start.
3. Select one feature and record the puppeteering result as a clip.
4. Go to the time frame specified in step 2.
5. Click the Clear Selection button and select another facial feature in the pane.
6. Start to puppet and record the motion of this selected facial feature.
7. When you stop recording, the motion of the selected feature will be layered into the facial clip.
8. Repeat Steps 3 to 6 until you are satisfied with the model’s expression results. Each recording will blend, layer by layer, the effects to the motion clip.

Using the Face Key Editor

CrazyTalk Animator integrates various key-editing panels into one single Face Key Editor. Use it to add/modify keys for Face, Head, and Eyes tracks.

<table>
<thead>
<tr>
<th>Setting the Head Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Face Key Editor, you can also set or modify the rotation/tilt keys of the character head.</td>
</tr>
</tbody>
</table>

Including the Rotation Status into a Key
1. Select the Head Orientation button in the pane.
2. If you are using the mouse as your input device, then press and hold the left-mouse button inside the facial feature pane.
3. Move the mouse around, and the model will rotate its head to match the mouse movement. A head key will automatically be set.

Including the Tilt Status into a Key
1. Select the Head Tilting button in the pane.
2. If you are using the mouse as your input device, then press and hold the left-mouse button inside the facial feature pane.
3. Move the mouse left and right to tilt the model’s head accordingly. A head key will automatically be set.

Using the Facial Tab
1. Select the desired facial features to set keys in the pane.
2. If you are using the mouse as your input device, then press and hold the left-mouse button inside the interactive area.
3. Drag the mouse in the interactive area to make the changes. The character’s head will automatically be set.

<table>
<thead>
<tr>
<th>Setting the Eye Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Face Key Editor, you can also set or modify the rotation/tilt keys of the character head.</td>
</tr>
</tbody>
</table>

Using the Template Tab
If you do not want to set an expression, one facial feature at a time; then it is recommended that you use templates. Especially for Sprite-based faces.
1. Switch to the Template tab.
2. Select a category from the Expression Style drop-down list.
3. If you are using the Sprite-Based face, then you may also select the For Comic category.
4. In the Template Library pane, click on the desired template.
5. Change the Expressiveness values to adjust the strength of the applied expression.

Using the Modify Tab
If you use the Facial tab to set facial keys, then you are actually modifying the values of each slider in the Modify tab. Therefore, you can use the sliders inside of this tab to fine-tune the values for each facial feature.
1. Switch to the Modify tab.
2. Drag the slider to change the value, the selected character will then change the facial expression accordingly.
CrazyTalk Animator provides a feature for you to embed expressions into any character. Just use the right-click menu to command the character to act any facial expression. The character can then be saved along with all the action commands.

Using the Action Menu for Expressions
1. Select a character containing an action menu with facial expressions.
2. Click the Action Menu button. You will see a menu pop up.
3. Select any command that does not include: Add New Command or Delete All Action.
4. The character will then start the expression command.

Character Animation – Body Animation

Five Approaches to Generating Body Movements

There are five main methods to generating body movements for a character.

Body Movements from the Library

The easiest way to have a character move is to apply templates from the Content Manager. To do this, simply click the Animation tab on the top panel.

Templates Containing Body Motions

You may apply body motions from the templates found in the library list:

- Motion
- Perform
- Action Menu
1. Select a character.
2. Double-click on the desired template (or drag and drop the template onto the character) from the Motion or Perform library.
3. The character will then act out the animation.

Note:
- How to distinguish between front or side motions:
  - Front motion: Has an “F” on the bottom-left icon.
  - Side motion: Has an “S” on the bottom-left icon.
- Each template, in the Perform libraries, contains Motion and Face (voice and expression) data. Applying a template of this type will have the character perform and speak with expressions on its face.

Using the Sprite Editor to Switch Hand Gestures

The body parts of a character are actually sprites with one or more elements inside. By using the Sprite Editor, you may switch to any elements in a body part, which all together compose the look of the character. You may also use this method to switch hand gestures during different time frames.

1. Select a character whose hands contain more elements inside.
2. Go to a different time frame.
3. Click the Sprite Editor button.
4. Pick one of the hands. You may then see all the elements listed in the Sprite Editor.
5. Select one of the elements which will set a Switch to the hand.
7. Different hand gestures will then be assigned.
8. Go to different time frames and repeat the procedure to assign more hand gestures to the character.
Using the Body Puppeteering Panel

1. Puppeteering - Character Transformation

In addition to the creating a path animation method, you may also use the **Body Puppeteering Panel** to create a character's transformation path.

1. Select a character.

2. Go to a specific time frame where you wish to start to puppet the character's transformation data.

3. Click the **Puppet Editor** button to show the puppet panel. If it brings up the **Face Puppet panel**, then click the **Switch to Body Animation** button. The **Body Puppeteering Panel** will now show.

4. Press the **Move** button down.

5. Press the **Space Bar** to start previewing. (Or click the **Preview** button and press the **Space bar**)

6. Press **Alt + Space bar** to start recording, or click the **Record** button and press the **Space bar** to start recording the motion during puppeteering. The motion can be triggered with the same mouse manners as you did in the preview mode.

7. Press **Space bar** or **ESC** key, to stop recording.

8. Go to the time frame in Step 2. Repeat the steps to puppet and record with the **Zoom** or **Rotate** buttons pressed.

The illustration below shows the **Zooming** results.

9. If you have puppeteered the **Move and Zoom** data of the character, then you will see the Transform Path.

---

2. Puppeteering - Base Motion

You may have the character act some preset full-body motions from the library. This saves a lot of time when you need the character to do common motions found in daily life.

1. Select **Base Motion** from the **Body Animation Profile** drop-down list.

2. Select the **Move**, **Idle**, **Talk** and **Mood** icon.

3. Pick any one motion template from the category list.

4. Press the **Space Bar** to start previewing. (Or click the **Preview** button and press the **Space bar**)

5. The character will then perform the built-in motion of the template when you move your mouse in a circle.

   - A clockwise circle motion will cause the character to move forwards.
   - A counterclockwise circle motion will cause the character to move backwards.
   - The faster the mouse moves, the faster the character moves.

6. Press the **Space bar** again to stop previewing.

7. Press **Alt + Space bar** to start recording, or click the **Record** button and press the **Space bar** to start recording the motion during puppeteering. The motion can be triggered with the same mouse manners as you did in the preview mode.

8. Press the **Space bar** or **ESC** key to stop recording.

9. Once the recording stops, a clip containing all the recorded motions will be stored as a single clip in the **Motion Track** of the character.

---

**Note:**

- Use the front preset for front characters, and the side preset for side characters. Mix and matching presets may sometimes cause unexpected layer issues.
- The **Front preset**: Represented with an “F” on the bottom-left of the icon.
- The **Side preset**: Represented with an “S” on the bottom-left of the icon.
The Solo Body Part Puppeteering method helps you puppeteer specific body parts by mixing and creating a lot more motions than what the Base Motion category provides.

1. Select a character.
2. Go to a specific time frame where you want to start puppeteering the character's body movements.
3. When the Body Puppeteering Panel displays, select Body Parts from the Body Animation Profile drop-down list.
4. Select the Head, Leg, Arm or Torso icons.
5. Pick a motion template from the body part category list.
6. Press the Space Bar to start previewing.
   (Or click the Preview button and press the Space bar)
7. The character will perform the built-in motion template when you move your mouse in a circle.
   - Move your mouse in a clockwise motion for the character to move forward.
   - Move your mouse in a counterclockwise motion for the character to move backwards.
   - The speed of the motion is determined by the speed of the mouse motion.
8. Press the Space bar again to stop previewing.
9. Press Alt + Space bar to start recording, or click the Record button and press the Space bar to start recording the motion during puppeteering. The motion can be triggered with the same mouse motions as the preview mode.
10. Press the Space bar or ESC key to stop recording.
11. Go to the time frame in Step 2. Repeat the steps to puppet and record by selecting individual body parts and motion presets.
12. Once the recording stops, a clip containing all the recorded motions will be stored as a single clip in the Motion Track of the character.

| Puppeteering - Body Parts |

### Slider Control and Mouse Control

There are two methods to triggering motions within the Body Puppeteering Panel: Slider Control and Mouse Control.

#### Slider Control Mode

If you switch to the Slider Control tab, then you can constantly change the character's motion weights and speed values during Previewing or Recording. The character’s motions react instantly to the values.

#### Mouse Control Mode

The main purpose for the Slider Control Mode:
- Previewing Motion
- Please note that recording during slider puppeteering is allowed.

1. Given a motionless character that moves from left to right, along a path, as below:
2. In the Body Puppeteering Panel, select the Jump preset from the Base Motion category.
3. Switch to the Slider Control tab.
4. Start to preview (hotkey: Space bar) or record (hotkey: Alt + Space bar).
5. The character starts to perform the preset motion again and again. You may drag the Exaggeration or Speed sliders to affect the motion in real-time.
6. The Speed value decides the speed of the looping motion.
7. Start to preview or record. The character will keep repeating the motion.

- The Speed value decides the speed of the looping motion.
- The Exaggeration value must be set before Previewing or Recording.
- Changing the Exaggeration value of may affect the motion weights during puppeteering.

| Looping once for a lower Speed value. |
| Looping several times for a higher Speed value. |
Masking Puppeteering and Multi-Layer Recording

Masking Puppeteering means to puppeteer individual body part by masking out the unwanted body parts of a Body Dummy, when you are using Full Body Puppeteering. You may extract a specific body part motion from the presets in the base motion.

Masking Puppeteering
1. Select one of the presets in the Base Motion.
2. Make sure that you have switched to the Mask tab in order to show the body dummy.
3. Press the Space Bar to start previewing.
   (Or click the Preview button and press the Space bar)
4. Deactivate the body parts of the Body Dummy in order to mask out the motions from these body parts.
5. Use the standard method to preview or record the character’s motion. Only the selected body parts will be puppeteered.

Multi-Layer Recording

Multi-layer Recording is about recording the character motions, layer by layer. It is helpful when you need to do the mix-recording. This way, the character can generate thousands of motion combinations from the limited number of templates. This method applies to both Full Body Puppeteering and Solo Body Part Puppeteering.

1. Follow the Masking Puppeteering procedure described earlier on this page, and record a motion of a specific body part.
2. Go to the time frame when the previous motion starts. Select another motion preset.
3. Pick other body parts on the Body Dummy.
4. Puppeteer and record the motions of the un-masked body parts.
5. Repeat to record motions of individual body parts (layer by layer). This way you may generate a whole new motion with your own puppeteering.

Using the Body Key Editor

CrazyTalk Animator integrates various key-editing panels into one single Body Key Editor. You may utilize it to add/modify transform keys to all the limbs on a character.

The Body Key Editor has two main functions:
- Producing key-by-key animations.
- Modifying existing motion keys.

Using Pose Mode - FK and IK

In the Pose mode, you may adjust the limbs with FK (Forward Kinematics) and IK (Inverse Kinematics) methods. You can do this in order to give characters a general pose, or you can slightly modify individual body parts in Body mode.

Using FK and IK
1. Select a character and click the Motion Key Editor button.
2. Pick a Hand. You will see two concentric circles for use with the FK method.
   - Drag the outer circle to rotate the hand, and the geared body, in an opposite direction.
   - Drag the inner circle to rotate the hand, and the geared body, in the same direction.
3. Pick a Leg. Drag the cross arrow inside the circle in order to use the IK method to relocate the feet.
   - If you want the joints of the legs to be in a correctly angled, then you need to drag the outer circle to form the angle first.
4. Pick the Body. Drag the cross arrow to move the pelvis of the character. This is easy when wanting the character bend his/her knees.
Using Body Transform - Transform any Body Parts

In Pose mode, you can only set the pose to characters. If you need to adjust detailed body parts, then switch to Body mode in order to fine-tune each body part with exact values.

Stretching Animation
1. Set the character’s pose in the Pose mode.
2. When the Body Key Editor displays, click the Body button.
3. The dummy pane will change to a detailed one.
4. Click one of the body parts, on the dummy pane, or click the part directly on the character. A transform handle box will appear around the body part.
5. Un-proportionally scale the selected body part.
   Please note that the child node (the shoe in this case) will also be affected.
6. Modify the child node in the same manner, to get the best results.

Detaching Animation
In addition to editing the size, you may also move the body parts away in order to create a detaching animation.
1. Select a character and open the Body Key Editor panel.
2. Go to a desired time frame where a body part starts to detach from the character and set a pose.
3. Go to another time frame and move the body part away (You may optionally resize the body part).

Using Face Mode - Facial Features
If you are using a sprite-based face, then you may use the Face mode for a more dramatic face effect. You can do this by moving, scaling or rotating the facial features. Please note that this function only applies to Sprite-based faces.
1. Select a character whose expression is already set.
2. Click the Face button. The dummy pane will change to the face feature mode.
3. Pick on the face dummy or directly click on the facial feature to select it.
4. Move, scale or rotate the facial feature.

Default Pose and Absolute Key

Inside the Motion Editor panel, you may use the Default Pose and Absolute Key to set transform keys to all body parts and facial features.
The Default Pose helps you reset the transform values for all body parts and facial features instead of resetting them manually. The Absolute Key sets transform keys according to the current status of the body parts and facial features. This forces a transition effect that starts from the present time frame.

Default Pose
1. Given a character whose body has been transformed many times, it is sometimes hard to reset everything manually.
2. To do this, go to another time frame and click the Default Pose button in the Motion Key Editor panel. All body parts will then return to their initial status.

Absolute Key
You may then use the Absolute Key feature to help you set a key to retain the current transform data. This helps so that the current pose is not destroyed by the auto transition feature when the pose is between two body motion keys.
1. Select a character, go to forward frame and set an ending pose.
2. The transition effect will auto-generate.
3. If you change the ending pose as shown in the illustration, then the transition animation will be auto-produced as shown in the right image.
4. If you wish to keep the middle pose in Step 2, then you must click the Absolute Key button in Step 2 to retain the pose.
5. Modify the ending pose key. The result should be as below:
| Saving a Pose |

After setting a character's pose, you may sometimes want to share the pose with another character. Instead of adjusting the new character again, you may use the Save Pose feature to easily share the same pose.

1. Select a character whose pose is already set.
2. Click the Save Pose button in the Motion Key Editor Panel. Save the pose as a new motion file (.ctMotion).
3. Drag and drop the new motion file onto another character. The characters are now all sharing the same pose.

Note:
- Please note that the Pose file is basically a one frame motion file with the same file extension (.ctMotion). It only stores Transform, as well as Sprite Switch keys of body parts. All the facial features are not included.

Utilizing the Action Menu for Body Motion

CrazyTalk Animator provides a feature for you to embed motions to a character. Simply use the right-click menu to command the character to act the motion. The character can then be saved together with all the action commands.

Using the Action Menu for Motions

1. Select a character containing an action menu with body motions.
2. Click the Action Menu button.
3. Select one of the commands in the menu.
4. The character will then start to perform the motion command.

Camera Animation

- Using Live Camera

Most of the time you pan, zoom and rotate the Preview Camera to build a scene, and to add and edit characters and props without setting any keys to the camera. However, if you need to produce a story with camera movements for dramatic tension, then you can use the Live Camera.

| Switching Camera |

1. Build a scene.
2. Click on the Camera Switch Mode button.
3. The working area will then switch to the Live Camera view. You can figure out the source of the view by the icon on the top-right.
4. Click the Camera button again to switch back to the Preview Camera view.

Using Live Camera

In the Live Camera mode you can pan, zoom and rotate the camera to auto-set a transform key to the animation camera.

1. When you are in Live Camera mode, click the Rotate button. The Camera transform panel will show.
2. Go to another time frame.
3. Enter values in the number fields of the panel to auto-set a key to the camera.
4. Repeat the steps until you complete the camera movements in the story.

- Switching Camera

You may use hotkeys to quickly set values instead of typing.
- Zoom: Alt + Both mouse buttons (or Alt + Rolling the mouse wheel - can not be undo)
- Move: Alt + Left mouse button
- Rotate: Alt + Right mouse button
- Linear: Camera moves at a constant speed.
- Smooth: Camera moves at a slow-fast-slow pace to smooth its movement.

- Click the Default Key button to set a neutral key to the camera.
Using Timeline

Introducing the Timeline

Click the Timeline button on the play bar to open the Timeline Editor. The Timeline Editor is where you edit animation keys and clips for actors, props, cameras, image layers, sounds, music, etc.

A. Track Selector

1. Track list: Click the Track drop-down list and select the items, in order to show/hide them and their master track buttons.

2. Object-related track: When you pick an item on the 3D viewer with this button down, the Timeline will only display the tracks of the picked item.

B. Motion Tracks

1. Item Name and Main Track Buttons: This track shows an item’s name and its master track buttons. Click on the name to select the item.

2. Track Buttons: Click these buttons to show/hide the master tracks of the picked item. Button Status:

   - Show all of its main tracks.
   - Hide all of its main tracks.

Track Button that contains multiple master tracks:

   - Facial - Voice Clip, Facial Clip and Facial Motion master tracks.

3. Main Track Name and Data:

   - This track shows the name and its data.
   - - This track shows the name and its data.
   - - Double click on the name to select all the data in the track.
   - - Double click on the name to select all the data in the track.

4. Display Sub-Tracks: Click this arrow button to show all sub-tracks.

5. Sub-Tracks Drop-down List: Click this drop-down list in order to show/hide sub-tracks.

C. Toolbar

1. Next, Previous (Tab, Shift + Tab) - Click these two buttons to snap the play head back to the previous, next keys or start-frame clip. The key or clip will be automatically selected.

2. Add key (Pro version only) - The Add Key button only works for the Transform, Opacity tracks, the Head, Face, Eye and all 1 sub-tracks under the Facial and Motion main tracks. - Double-click on the timeline cell area to add a key, or press this button. - Keys can also be automatically added when users alter any key information in the Modify Panel.

3. Cut/Copy/Paste (Pro version only)/Delete - Cut: Click the Cut button to cut the target key, or clip, in the clipboard. - Copy and Paste: Click on the copy and paste button, or use hotkey Ctrl + C on selected keys or clips to copy, and Ctrl + V to paste to the target frame (single or multiple keys). - Delete: Click on the Delete key or Delete button to delete highlighted keys or clips.

4. Group and Ungroup (Pro version only) - Click the Group button to collect keys into one clip for easily copying and moving. - Click the Ungroup button to extract the keys inside of a clip and bring them into corresponding tracks. - Both buttons only work in the sub tracks under Facial and Motion button.

5. Break (Pro version only) - Break works for Clip type data in all tracks/groups except for clips in the SoundTrx item. - Click the Break button to split the selected clip at a current frame into two new clips.

6. Loop/Speed Switch (Pro version only) - The Loop/Speed Switch button works to Clip data in all tracks/groups except for clips in the SoundTrx item. - Press the Loop/Speed Switch button UP and drag the clip’s right edge rightward to decelerate/accelerate the speed. - Press the Loop/Speed Switch button DOWN and drag the clip’s right edge rightward to repeat the clip.

7. Music Modify - Click this button to show a panel to modify the clips under the SoundTrx item.

8. Zoom in/out (+, -) Actual size Fit window - Click the Zoom in/out buttons to increase or decrease the time (cell) unit size. - Click the Actual size button to show the time unit represented as 30 frames per second. - Click the Fit window button to view all the timeline items within the timeline window space.

9. Play and Stop - Click the button to play the project, click again to pause. - Click the button to stop playing.

10. Current Frame - This field shows the current frame number on the timeline. You may also type-in the frame number to jump to the target frame. This allows you to go to your precise target location; this is especially convenient for animation with clear timing control.
D. Time Scrub

1. Time unit Bar
   Drag the bar to move the displayable range to a desired time frame.
   Drag the right edge to change the size of the displayable range.

2. Play back and Export Range
   Drag the two tags to decide the range for playing back or exporting.

3. Play Head
   Drag to move to the desired time frame.

Dockable Timeline

The floating Timeline can be docked under CrazyTalk Animator main program.

Key/Clip Selections

- Select single key
  Single click on the target key/clip, the selected key/clip will then be highlighted in red.

- Tab Key
  - Press Tab to jump to the next key/clip.
  - Shift + Tab to jump to the previous key/clip.

- Select All keys
  - Double-click on the target track name.

- Multiple key/Clip selection
  - Drag the cursor in the specific track to highlight the keys/clips covered under it.
  - Use Ctrl + LBM (Left Mouse Button) to select multiple keys/clips.
  - Use Shift + LBM to select the adjacent keys/clips.

Clip and Key Priority

Facial expressions could come from different tracks. Therefore, during playback, the program must have a specific priority when a time frame contains data from different tracks.

Sprite-based head

The facial expressions generated for the Sprite-based head can be from the Sprite track, the Motion Clip clips, the Face Clip clips, the Face track keys, and the Voice Clip clips. When the project plays and meets all these clips or keys, then there is a certain priority for displaying the effect from these tracks.

- General Facial Features:
  Keys in the Sprite track > Clips in the Facial Motion track > Clips in the Face Clip track > Keys in the Face track.

- Mouth:
  Keys in the Sprite track > Clips in the Voice Clip track > Clips in the Facial Clip track > Keys in the Face track > Clips in the Facial Motion track.

Morph-based head

The facial expressions generated for the Morph-based head come from the Face Clip clips, the Face track keys, and the Voice Clip clips.

- Clips in the Facial Clip track > Keys in the Head, Face, Eye tracks
Using Tracks

**Motion Layer Tracks**

The **Motion Layer tracks** are important tracks for fine-tuning an actor’s motion. You may generate simple **Key Frame Animation** or add **Animation Layers** to an existing animation clip.

**Motion Layer Concept**

1. **Motion Clip and Transform Key**
   - Given a motion on a character, before the motion is modified with a **Transform key**.

2. **Motion Clip and Sprite Switch**
   - Given an existing motion of a character, before the motion is modified with a **Sprite switch**.

**Key Frame Animation**

To fully understand **Key Frame Animation**, you will need to remove all the motion clips in the **Motion main track**. Then create your own key by key motion for the actor.

Follow the steps below to generate **Key Frame Animation**:

1. Select a character, and go to the desired time frame to create the first motion key with the **Body Key Editor**.
2. In the **Body Key Editor** window, utilize the **Pose** and **Body** mode to set a motion key.
3. Go to another time frame.
4. Add another key.
5. Play the project to see the results. The transition effect will automatically be generated between these two keys.

**Modifying Sound Clips**

**CrazyTalk Animator** provides three tracks for adding audio files. After the audio files are loaded, you may adjust the basic settings for the individual audio clips.

**Importing Sound**

1. Click the **Import Sound** button in the **Stage Mode**.
2. Select the target track you want the sound to be put in to.
3. Open the **Timeline** and show all the tracks of the **SoundTrx**.

**Modifying Sound Clips**

1. Select the target sound clip.
2. Click the **Music Modify** button on the timeline toolbar.
3. Drag the slider to decide the **Volume**, **Fade In** and **Fade Out** percentage.
Introducing the Export Page

CrazyTalk Animator now offers the convenient feature of exporting your project into multimedia formats that are compatible with a wide range of devices. For instance, you can now convert your work to an AVI file with DVD and HD quality. You can also convert it into sequenced image (BMP/JP2/GIF/PNG) files to broadcast on a web server. Exporting Flash files is also supported so you may output your projects as Flash animation.

A. Media Types
   Mode Tabs
   - Output Video/Widget/PapVideo/Wave Files
   - Output Sequenced Images and GIF Animation Files
   - Output FLV Files for Web

B. Format and Quality
   In this section, you may choose the image, video and audio quality output.
   - Utilize the Format drop-down list to decide the format of the exporting media.
   - Drag the Video and/or Audio sliders to set the quality of the exporting media.

Note:
- By default, the export format is WMV; however, if you want to further edit the exported video with an external video editor, please choose AVI RAW data for lossless post-production; this maintains color fidelity for high quality production.
- If you wish to export as a 3D Animator, WPgTool or papVideo with transparent background, then please remember to set the background in solid color.
- If you want to export into a WMV file format, then you will need to first download and install the WMV/Encoder from the Microsoft website.

C. General Settings
   In this section you may set projects as 3D media and set other general settings.
   - 3D Output: Creating a 3D Stereo media.
   - General Settings: Specifying general export settings for exporting.

D. Export Tools
   Export Buttons
   - Preview: Click this button to preview the current frame results.
   - Save: If you have installed Realusion WidgetCast, then this button will be enabled. You may then click it to export your project directly into this program.
   - Export: Click this button to export your project in accordance to your settings.